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1  Introduction
This manual provides detailed information about installing and upgrading 
RAPIDComm® Data Management System to version 7.0. RAPIDComm 
system software version 7.0 provides important features and 
enhancements that can help improve the efficiency and productivity of 
your laboratory, while offering greater convenience to the RAPIDComm 
Data Management System operator.
RAPIDComm Data Management System installation options include server, 
workstation, and client. 

Understanding Your RAPIDComm System Deployment
When planning for the deployment of the RAPIDComm Data Management 
System within your organization, you need to understand the following 
system components before beginning the installation process: 
• RAPIDComm Server
• RAPIDComm Workstation
• RAPIDComm Client
• Device Connectivity
• RAPIDComm Security, Users, and Groups

RAPIDComm Server
As a guideline, Siemens recommends that the RAPIDComm Data 
Management System server software be installed on a system dedicated to 
the RAPIDComm system or a dedicated instance on a VMware virtual 
server. It should not be combined with other applications that may impact 
performance or communications.
Note  The RAPIDComm server supports installation of POCcelerator® on the 
same server using the same SQL Server database instance with minimal 
performance impact.
The RAPIDComm Data Management System server, in addition to database 
services, also includes device communications functions and user interface 
functions. The RAPIDComm system supports a remote database installation 
where the RAPIDComm server interfaces with a dedicated SQL Server 
database instance on a database management server. 
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The RAPIDComm server installation includes all the workstation 
communications functions, which you can use if you are not configuring 
other independent workstations. The server should be used as a 
workstation only if no more than 25 devices (analyzers and instruments) 
are to be connected.
The RAPIDComm Backup Configuration utility is installed on the 
RAPIDComm server and is used to manage your database backup activities. 
With this utility you can configure backup settings, create a schedule for 
full and incremental backups, run a full backup, and view backup job status 
and history.

RAPIDComm Workstation
The RAPIDComm Data Management System workstation installation 
contains both the device communication functions and the application 
user interface. One or more RAPIDComm system workstations may be 
deployed to distribute the communications workload when a large number 
of devices are being connected to the RAPIDComm system. 
The need to implement and use a workstation computer may vary and 
depends on the amount of data transmitted between the instruments and 
the RAPIDComm program, and the reliability and performance of the Local 
Area Network. 
As a guideline, Siemens recommends implementing workstation 
computers whenever 25 or more devices are connected to the RAPIDComm 
program or when devices are located in different geographical locations 
from the RAPIDComm server and are connected over a Wide Area Network. 
If used, the workstation computer must remain on and connected at all 
times to permit communication between the attached devices and the 
RAPIDComm server. You should consider dedicated workstations to 
support configurations that use multiple device connections.

RAPIDComm Client
The RAPIDComm Data Management System client contains only the 
application user interface. The RAPIDComm system client can be installed 
on any hospital PC where access to the RAPIDComm application is needed, 
as long as the PC meets the listed hardware and software requirements.
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Device Connectivity
RAPIDComm supports the following devices:

Network and Serial Connections
Devices may connect to the RAPIDComm Data Management System server 
or RAPIDComm system workstations via network or serial connectivity.
RAPIDLab 1200 series, RAPIDPoint 400/405, and RAPIDPoint 500 systems 
have connectors for both a network connection and a serial connection. 
RAPIDLab 800 and RAPIDLab 248/348/348EX series systems have serial 
connectors. If these systems are to be connected to the network, they must 
first be connected serially to a communication workstation or to a network 
converter. (Your technical support staff may refer to this network converter 
as a "Lantronix box.")
CLINITEK Status, DCA Vantage, and Stratus CS 200 devices have a network 
connection only.

Device Link
RAPIDLab 1200 series, RAPIDPoint 400/405, and RAPIDPoint 500 systems 
require network connectivity to remotely access analyzers with the Device 
Link functionality in the RAPIDComm application.

Modality Device
Blood Gas RAPIDLab® 248/348

RAPIDLab® 348EX
RAPIDLab® 8xx
RAPIDLab® 12xx
RAPIDPoint® 4xx
RAPIDPoint® 500
RAPIDPoint® 500e

Cardiac Stratus® CS 200 (available outside of US 
only)

Diabetes DCA Vantage®

Urinalysis CLINITEK Status® Connect
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RAPIDComm Security, Users, and Groups
Domains vs. Local Security
RAPIDComm Data Management System security is integrated with 
Windows user and group security management. The RAPIDComm system 
will operate in domain or local security environments. 
In a domain environment, the security of each RAPIDComm system is 
determined by the configuration in Active Directory.
In workgroup environments, security is managed locally and RAPIDComm 
users and groups must be configured on each PC in the RAPIDComm 
workgroup.

Users and Groups
RAPIDComm Data Management System users and user groups are 
configured in the Windows operating system. Some users and groups are 
required before application installation and configuration can be started.
Note  The account used for starting RAPIDComm system services must 
have access to the Active Directory system in order to validate Active 
Directory users.
There are 2 types of users and groups within the RAPIDComm Data 
Management System: 
• Users required for installation
• Users required after installation to use the RAPIDComm program

Users Required for Installation
• RAPIDComm Administrator account(s) – User accounts, which when 

assigned to the RAPIDComm Administrator Group, have access to all 
functions in the application.

• RAPIDComm Service account – A user account necessary for the 
RAPIDComm system's services to automatically start at system boot. 
This should be an account that is dedicated to starting the RAPIDComm 
services and not a general user account that may be removed or have 
its rights restricted.

• RAPIDComm Administrator group – This user group must exist before 
installation of the RAPIDComm system and it must contain at least one 
user account so that the RAPIDComm system can be installed and 
configured. RAPIDComm Admin is recommended as a name for this 
group. The RAPIDComm Administrator user account(s) and group also 
function within the Application Operations category.
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Users Required Post Installation for Application Operation
• RAPIDComm Data Management System Users – User accounts, which, 

when assigned to one of the RAPIDComm groups, are allowed access to 
application functionality based on the roles assigned to that group.

• RAPIDComm Data Management System Groups – Groups defined to 
facilitate access to application functionality based on role assignment. 
Table 1-1 lists the recommended groups and role assignments.
Note  User accounts should be set up as domain accounts by your IT 
department and must be configured as Global Security groups. Domain 
local groups are not supported.

Table 1-1:     Recommended Groups and Role Assignments

Miscellaneous Security Requirements
Firewall Modifications
If local server or workstation computers are using a firewall, ports must be 
opened to allow server access. Any ports configured for Hospital 
Connections must also be open for access. 

Windows User 
Group

RAPIDComm Data Management System Role 
Assignments

RAPIDComm 
Admin

Application Administrator, Device Administrator, 
Device Data Editor, Device Manager, Device Operator, 
External Systems Manager, Operator Manager, Patient 
Data Editor, Patient Data Manager, Patient Sample 
Reporter, Remote Device Operator, Report Designer, 
Web User1

1. Web User should be assigned to any RAPIDComm group using the RAPIDComm Web             
application.

RAPIDComm Key 
Operator

Device Data Editor, Device Operator, Patient Data 
Editor, Patient Sample Reporter, Report Designer, Web 
User1

RAPIDComm 
Routine 
Operator

Device Operator, Patient Sample Reporter

RAPIDComm 
Technical 
Support

Application Administrator, Device Administrator, 
Device Data Editor, Device Manager, Device Operator, 
External Systems Manager, Operator Manager, Patient 
Data Editor, Patient Data Manager, Patient Sample 
Reporter, Remote Device Operator, Report Designer, 
Restricted Access, Web User1
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Table 1-2 lists the ports that must be open for server and device access.
Note  This does not apply to servers or workstations that are within the 
enterprise firewall. It applies only to local systems using a firewall.

Table 1-2:     Ports Configured for Hospital Connections

Virtual Local Area Networks (VLANs)
The preferable configuration of the RAPIDComm system in a VLAN 
environment is to have the server, workstations, and instruments within 
the same VLAN. However, due to IT security requirements, RAPIDComm 
Data Management System servers may need to be on another LAN or 
VLAN. For these situations, ensure that each RAPIDComm system 
component (server, workstation, client, or instrument) has an entry in DNS 
and/or WINS for proper connectivity operation.

RAPIDComm Printer Configuration
Report printing is a function of the business service on the RAPIDComm 
server. For those reports to operate properly, any local or network printer 
installed on a workstation or client system must also be installed on the 
server and the RAPIDComm service account must have access rights to the 
printer. 

Connection Ports Open for Access
RAPIDComm Server/Workstation 8890, 8895
Blood Gas devices 3001
CLINITEK Status 6002 (default)
DCA Vantage 7002 (default)
Stratus CS 200 (available outside of US only) 9002 (default)
Remote Device Link (within RAPIDComm) 5900
Device Link (available through Internet Explorer 
when using the Web App)

5443

Secure Connection (when using SRS, Web App) 443
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The following are the requirements for printer installation:
• Workstations and client systems

○ Printers may be installed locally on the workstation or client. All 
local printers must be configured as shared printers.

○ Network printers may be installed on the workstation or client.
• Server

○ All printers to be used in the RAPIDComm environment, whether 
local to the workstation or client, or networked printers, must be 
installed on the RAPIDComm server. 

○ When installing printers on the RAPIDComm server, you must be 
logged in as the RAPIDComm service account.



Introduction

Page 12 of 56 RAPIDComm 7.0 Installation and Upgrade Instructions 11317407 Rev. B, 2021-12



RAPIDComm 7.0 Installation and Upgrade Instructions 11317407 Rev. B, 2021-12 Page 11 of 56

2  Installing RAPIDComm
Preinstallation Considerations

Prior to initiating the installation process, note the following:
• Siemens recommends that your IT department perform this 

installation.
• To install version 7.0, you must log into Windows with administrative 

privileges.
• Use the worksheet in Information Required for Installation on page 15, 

to identify and record the information you will need to reference 
during the installation process.

• Use the post-installation worksheets in Information Required for Post 
Installation on page 17, to identify and record information you will 
need to reference after the installation is complete.

• The RAPIDComm Data Management System supports blood gas, 
urinalysis, diabetes, and cardiac or any combination of these 
components. You will need to select the applicable device 
component(s) that you have licensed during the installation process.

• After you complete the installation, you have a 30-day grace period in 
which to register components.
If you do not register a component within the 30-day grace period, the 
component becomes nonfunctional until you complete the 
registration.

• The installation program automatically installs the RAPIDComm Backup 
Configuration utility. You use this utility to configure your backup 
settings, create scheduled backups, run a full backup, and view backup 
job status and history.
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Preinstallation Checklist
Use the following checklist to ensure all required pre-installation 
procedures are completed.  

□ Verify Hardware and Software Requirements
Server
□
□

Server hardware configuration meets criteria in Table 2-1, 
Minimum Hardware Requirements
Server software meets criteria in Table 2-2, Supported System 
Software Configurations 

□ Microsoft Message Queuing (MSMQ) is installed. 
(From Windows Features, enable Message Queuing Server). 

□ If you are connecting RAPIDComm to a remote database, 
MSDTC is configured. See Configuring MSDTC for Remote 
RAPIDComm Databases on page 16.

Workstation (if applicable)
□
□

Workstation hardware configuration meets criteria in 
Table 2-1, Minimum Hardware Requirements
Windows 7, Windows 8.1, or Windows 10 software meets 
criteria in Table 2-2, Supported System Software 
Configurations

□ Microsoft Message Queuing (MSMQ) is installed.
(From Windows Programs and Features, enable Microsoft 
Message Queue (MSMQ) Server Core). 

Client (if applicable)
□
□

Client hardware configuration meets criteria in Table 2-1, 
Minimum Hardware Requirements
Windows 7, Windows 8.1, or Windows 10 software meets 
criteria in Table 2-2, Supported System Software 
Configurations

□ Identify Server, Application Administrator, and Service Account 
Information. See Information Required for Installation on page 15.
□ Identify Hospital Connection, Analyzer, Client and User 
Information. See Information Required for Post Installation on page 17.
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System Requirements
Only install this software if your hardware and software meet the 
requirements in this section. 

Hardware Requirements for RAPIDComm Software 
Installation
To properly scope your hardware selection, consider the following 
guidelines: 
• Be sure to include long-term requirements in your decision-making 

process. The RAPIDComm server software should be installed on a 
system dedicated to the RAPIDComm Data Management System.
Note  The RAPIDComm server supports installation of POCcelerator® on 
the same server using the same SQL Server database instance with 
minimal performance impact.

• A dedicated uninterrupted power supply (UPS) is recommended for all 
RAPIDComm servers and workstations.

• In addition to the normal disk requirements for operating system and 
site-specific software, the RAPIDComm software has minimum 
hardware requirements as described in Table 2-1, Minimum Hardware 
Requirements.

Table 2-1:     Minimum Hardware Requirements

System CPU RAM
Disk Space 
Requirements

Server Recommended:
Intel Xeon E5620 
(4 core, 2.4 GHz, 12MB 
L3, 80W) 

8 GB 
minimum 

Software: 150 MB
Database: 40 GB 

Workstation Recommended:
Intel Core i5-3470 
(4 core, 3.20 GHz, 6 MB 
cache)

4 GB
minimum

Software: 150 MB

Client Recommended:
Intel Pentium G645 
(2 core, 2.90 GHz, 3 MB 
cache)

2 GB
minimum

Software: 150 MB
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Software Requirements for RAPIDComm Software 
Installation
Table 2-2, Supported System Software Configurations lists the server and 
client/workstation configurations supported by RAPIDComm 7.0. If your 
current system software configuration does not meet the levels listed, do 
not proceed with the installation. Contact your local Siemens support 
provider for assistance. 
The service pack recommendations in Table 2-2  are those installed during 
validation. Siemens recommends that you install the most current service 
packs and updates. When installing any updates, you should create a 
restore point manually if the upgrade does not create one.

Table 2-2:     Supported System Software Configurations

Component OS Service 
Pack

Microsoft 
SQL

Service 
Pack

Server Windows Server 
2016 (64-bit)

N/A SQL Server 2016 
(64-bit)

N/A

Windows Server 
2012 R2 (64-bit)

N/A SQL Server 2014 
(64-bit)

N/A

Windows Server 
2012 R2 (64-bit)

N/A SQL Server 2012 
(64-bit)

SP2

Workstation/
Client

Windows 7 
Professional  
(32-bit and 64-bit)

SP1 N/A N/A

Windows 8.1 Pro  
(64-bit)

N/A N/A N/A

Windows 10 Pro  
(64-bit)

N/A N/A N/A
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Information Required for Installation
You need to identify the following information to perform the installation:
• RAPIDComm server 
• Application Administrator Group 
• Service Account 
Record this information in Table 2-3, Installation Worksheet, and refer to it 
during the installation process. If you do not know this information, 
contact your IT administrator.

Table 2-3:     Installation Worksheet

Field Value
RAPIDComm Server

RAPIDComm Server 
Name
SQL Server Name

Application  
Administrator Group

User Name
User Password
Group Name
For example, 
RAPIDComm 
Admin
Domain

Service Account
Account User Name
User Password
Domain
Group Name 
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Configuring MSDTC for Remote RAPIDComm Databases
To use a remote database in RAPIDComm, you must configure Microsoft 
Distributed Transaction Coordinator (MSDTC) on both the RAPIDComm 
application Server and the remote SQL Server database instance.
You do not need to configure MSDTC if the SQL Server database is local, 
that is, it is installed on the same server as the RAPIDComm application.
For new RAPIDComm installations, you should configure MSDTC prior to 
installing the RAPIDComm software.
To configure MSDTC, perform the following steps on the remote SQL 
Server database server instance that hosts the RAPIDComm database. 
1. Log in to SQL Server using the Administrator Account.
2. Click Start, click Run, type dcomcnfg and then click OK to open the 

Component Services window.
3. In the console tree, expand the Console Root folder by clicking 

Component Services > Computers > My Computer > Distributed 
Transaction Coordinator and then Local DTC.

4. Right-click Local DTC, and click Properties to open the Local DTC 
Properties dialog.

5. Click the Security tab, and under Security Settings, select the 
Network DTC access checkbox.

6. Under Transaction Manager Communication, select the Allow 
Inbound and Allow Outbound checkboxes.

7. Accept all of the remaining defaults, and click OK to confirm and save 
the changes.

8. A confirmation message may appear indicating that the MSDTC service 
will be stopped and restarted. Click Yes to proceed.

9. If a confirmation message appears indicating the MSDTC service was 
restarted, click OK to acknowledge it.

10. On the RAPIDComm application server, log in using the Administrator 
account, and repeat steps 2–9.
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Information Required for Post Installation
You need to identify the following to complete post-installation 
procedures:
• Hospital Connection Information
• Device Information
• Client Information
• RAPIDComm User Information
Record this information in the appropriate post-installation worksheets and 
refer to it after installation. If you do not know this information, contact 
your RAPIDComm system administrator or IT administrator.
Note  Refer to the online RAPIDComm User’s Manual for detailed 
information on setting up the RAPIDComm application. 

Hospital Connection Information
Specify whether a client or server connection is used for each hospital 
system. A client connection uses the IP /Hostname and port for the HIS/LIS 
system. A server connection uses a port that will open on the RAPIDComm 
server to accept connections.
When setting up your hospital connections, the ports you assign must be 
unique and cannot be assigned to any other connection.
Table 2-4:     Hospital Connections

Connection
Client or Server 
Connection

Hostname or 
IP Address Port

ADT
ADT
Orders
Orders
Orders
Patient Query
Results
Results
Results
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Device Information 
Identify the following information for each device:

Table 2-5:     Devices 

Device Name
Hostname or 
IP Address Device Type Location
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Client Information
Identify the following information for each client:

Table 2-6:     Clients

Client Name
Hostname or 
IP Address Location
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RAPIDComm User Information
Identify the following information for each RAPIDComm user. 
Use a separate line for each device type for a given user.
Note  The analyzer password is also needed but should not be recorded on 
this worksheet.
Table 2-7:     RAPIDComm Users

User Name Login 
Account

Device Type(s) 
Used

Security 
Access Level
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Installing RAPIDComm Data Management System 
Software on the Server

To install the RAPIDComm Data Management System software on the 
server:
1. Log on to the RAPIDComm server using an account that has operating 

system administrative permission and administrative access to the SQL 
database server.

2. Open the folder that contains the installation files, and double-click 
setup.exe.

3. The RAPIDComm installation checks for the installation of Microsoft 
.NET Framework 4.5.2 Full and SAP Crystal Reports runtime engine for 
.NET Framework 4 (x86 or x64). If either or both are not installed it will 
install them before installing the RAPIDComm software.
Note  During the installation of .NET components, do not use the 
Cancel button. If the installation of either component fails, the value in 
the Status column will indicate Failed and you will receive a message 
noting the failure and asking if you want to continue. When prompted, 
click No, restart your server, and then begin the installation again. If it 
fails a second time, contact your local Siemens support provider for 
assistance. 
Note  These components should not be removed once installed.
a. Click Install if instructed to install either of these products.
b. Microsoft .NET Framework components will be installed first (if 

missing), which will take several minutes and may require a restart 
when finished.

4. If a restart is requested you may need to log on again to continue the 
installation. The program may also prompt you to run the Setup.exe 
file again. If so, click Run. You will again be prompted to install the 
Crystal Reports runtime engine. Click Install. 

5. On the Welcome window, click Next.
6. Either accept the default installation directory and continue to step 7 

(recommended), or click Change to select a different directory and 
perform the following steps: 
a. On the Change Current Destination Folder window, browse to or 

create an alternate directory.
b. Click OK to confirm and close the window.

7. Click Next.
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8. On the Installation Type window, select RAPIDComm Server, and 
then click Next.

9. On the License Agreement window, click I accept the terms in the 
license agreement and click Next.

10. On the Device Component Selection window, select the components 
included in your purchased license, and click Next. 

11. If connecting to a local SQL database, go to step 13.
12. If connecting to a remote SQL server, perform the following steps: 

a. Click Browse and select the appropriate remote server.
Note  Refer to the RAPIDComm Server section of the worksheet in 

Information Required for Installation on page 15, for this 
information. 

b. Click OK to return to the Installation window. 
13. Click Next.
14. On the Customer Information window, type the site name in the 

Institution name field, and then click Next.
15. On the RAPIDComm Service Account window, enter the service 

account information in the Account, Password, and Domain fields, 
and then click Next.
Note  Refer to the Service Account section of the worksheet in 
Information Required for Installation on page 15, for this information.

16. On the RAPIDComm Administrators Group window, enter the 
appropriate Group name and Domain (computer name), and then 
click Next.
Note  Refer to the Application Administrator section of the worksheet 
in Information Required for Installation on page 15, for this 
information.

17. Click Install.
18. When the installation is complete, click Finish.

The program will prompt you to create database backup jobs using the 
RAPIDComm Backup Configuration utility. 

19. Open the utility, and follow the instructions on the window to 
configure your backup options. Refer to the RAPIDComm online Help 
for more information on configuring backup jobs.
Note  Incremental backups start after the first scheduled full backup, so 
a full backup should be scheduled within a day of installation.
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Installing RAPIDComm Data Management System 
Software on Workstations and Clients

To install the RAPIDComm Data Management System on a workstation or 
client:
1. Log on to a RAPIDComm workstation or client using an account that 

has operating system administrative permission.
2. Open the folder that contains the installation files, and double-click 

setup.exe.
3. The RAPIDComm installation checks for the installation of Microsoft 

.NET Framework 4.5.2 Full and SAP Crystal Reports runtime engine for 

.NET Framework 4 (x86 or x64). If either or both are not installed the 
program will install them before installing the RAPIDComm product.
Note  During the installation of .NET components do not use the 
Cancel button. If the installation of either component fails, the value in 
the Status column will indicate Failed and you will receive a message 
noting the failure and asking if you want to continue. When prompted, 
click No, restart your server, and then begin the installation again. If it 
fails a second time, contact your local Siemens support provider for 
assistance. 
Note  These components should not be removed once installed.
a. Click Install if instructed to install either of these products.
b. Microsoft .NET Framework components will be installed first (if 

missing), which will take several minutes and may require a restart 
when finished.

4. If a restart is requested, you may need to log on again to continue the 
installation. The program may also prompt you to run the Setup.exe 
file again. If so, click Run. You will again be prompted to install the 
Crystal Reports runtime engine. Click Install.

5. On the Welcome window, click Next.
6. Either accept the default installation directory and continue to step 7 

(recommended), or click Change to select a different directory and 
perform the following steps: 
a. On the Change Current Destination Folder window, browse to or 

create an alternate directory.
b. Click OK to confirm and close the window.

7. Click Next. 
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8. On the Installation Type window, select RAPIDComm Workstation or 
RAPIDComm Client, and then click Next.

9. If you are installing the workstation software, the RAPIDComm Service 
Account window appears. Enter the service account information in the 
Account, Password, and Domain fields, and then click Next.
Note  Refer to the Service Account section of the worksheet in 
Information Required for Installation on page 15, for this information.

10. On the Server Information window, enter the appropriate 
RAPIDComm system server name, and then click Next.
Note  Refer to the RAPIDComm Server section of the worksheet in 
Information Required for Installation on page 15, for this information.

11. Click Install.
12. When the installation is complete, click Finish.

Registering Product(s)
The RAPIDComm Data Management System software can include Blood 
Gas, Cardiac, Diabetes, Urinalysis or any combination of the these 
components. You have a 30-day grace period to complete the required 
registration.
You register components after you have finished installing the 
RAPIDComm software on the server.
To register component(s):
1. Obtain the product key you received in your confirmation email.
2. Log on to the RAPIDComm Data Management System software as an 

Application Administrator.
3. Click Utilities > Product Registration.
4. Follow instructions on the window to complete the product 

registration.
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3  Installing or Upgrading the RAPIDComm 
Web Application

This chapter describes the RAPIDComm 7.0 Web Application (Web App) 
software system installation procedures, including system requirements, 
access, and instructions to get started. 

Prerequisites
To install the RAPIDComm Web App, you must use:
• Administrator rights 
• Microsoft .NET Framework 4.5.2 (installed by the program if missing)
• Windows IIS Server
• HTTPS protocol, which ensures communications between your browser 

and the Web App are encrypted. In addition, you are responsible for the 
installation and maintenance of SSL certificates. 

Windows IIS Server
Windows IIS is the Microsoft Web Server that must be installed for the 
RAPIDComm Web Application to function. The IIS Server can be installed 
locally or on a remote server accessible to RAPIDComm. IIS must be 
installed using the Administrator account on Windows Server 2008 R2, 
Windows Server 2012 R2 or Windows Server 2016.
Note  The IIS Web Server can be established on the existing RAPIDComm 
Server, or you can use a separate IIS Web Server.
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System Requirements
Table 3-1:     Prerequisites for IIS Web Server

Component Notes
Computer Workstation: 
32-bit or 64-bit

• Administrator privileges on 
computer

• Retain IIS Web Server name or IP 
address

Windows Server 2016 IIS installed with the following role 
services enabled:
• Common HTTP Features: 

Static Content
• Performance:

Static Content Compression
• Application Development:

ASP.NET 4.6
• Management Tools:

IIS Management Console
IIS Management Scripts and Tools 

IIS installed with the following feature 
enabled:
• .NET Framework 4.6 feature: 

ASP.NET 4.6
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Table 3-2:     Prerequisites for Web App Client 

Windows Server 2012 R2 IIS installed with the following role 
services enabled:
• Common HTTP Features: 

Static Content
• Performance:

Static Content Compression
• Application Development:

ASP.NET 4.5
• Management Tools:

IIS Management Console
IIS Management Scripts and Tools 

IIS installed with the following feature 
enabled:
• .NET Framework 4.5 feature: 

ASP.NET 4.5
Windows Server 2008 
with SP2

IIS installed with the following role 
services enabled:
• Common HTTP Features: 

Static Content
• Performance:

Static Content Compression
• Management Tools:

IIS Management Console
IIS Management Script and Tools 

Microsoft .NET 
Framework 4.5.2 Full

If not installed, the program will install.

Component Notes
Apple iPad (iOS 5.0 or 
newer) 

Component Notes
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Installing Windows IIS on Windows Server 2012 R2 or 
Windows Server 2016
1. Open Server Manager.
2. At the top right, click Manage and select Add Roles and Features.

The Add Roles and Features Wizard starts. 
3. Click Next.
4. The Select installation type window appears. Click Next to accept the 

defaults.
5. The Select destination server window appears. Click Next to accept 

the defaults.
6. The Select server roles window appears. Scroll down and select Web 

Server (IIS) and then select Web Server.
7. Select the IIS roles for Windows Server 2012 R2 listed in Table 3-1, 

Prerequisites for IIS Web Server.
8. Click Next.
9. The Select features window appears. Click Next to accept the defaults 

and continue.
10. The Confirm installation selections window appears. Click Install to 

complete installation.
11. Click Close.

Computer Workstation: 32-
bit or 64-bit
Web Browser:
• Microsoft Internet 

Explorer 11
• Microsoft Edge 
• Google Chrome
• Mozilla Firefox
• Apple Safari (on iPad)

• IIS Web Server name or IP address
• Internet Explorer requires 

Compatibility View to be turned 
off. Click Tools > Compatibility 
View Settings > and uncheck 
“Display intranet sites in 
Compatibility View”.

Component Notes
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Installing Windows IIS on Windows Server 2008 R2
1. Open Server Manager.
2. Scroll down to the Roles Summary section, and click Add Roles. 

The Add Roles wizard starts. 
3. Click Next

The Select Server Roles window appears. 
4. Select Web Server (IIS) and click Next.

The Web Server (IIS) window opens. 
5. Click Next.
6. Select the IIS role services for Windows Server 2008 listed in Table 3-1, 

Prerequisites for IIS Web Server.
7. Click Next.
8. Confirm your selections and click Install to complete installation.
9. Click Close.
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Installing RAPIDComm Web App Software
1. On the computer that you have chosen to be the IIS Web Server for the 

RAPIDComm Web App, log on as an administrator. 
2. Open the folder that contains the installation files and double-click 

setup.exe.
3. The installation checks for the installation of Microsoft .NET Framework 

4.5.2. If it is not installed, it will prompt you to install it before installing 
the RAPIDComm Web App software. Click Install.

4. The Welcome window appears. Click Next to continue.
5. The License Agreement window appears. Click I accept the terms in 

the license agreement.
6. Click Next to continue.
7. The Destination Folder window appears. Click Next to continue and 

accept the default folders.
8. The Web Site Selection window appears. Click Next to accept the 

Default Web Site entry.
9. The RAPIDComm Server window appears. Click Next to keep the 

default localhost if the RAPIDComm server is on the same system as 
the IIS Web Server. If the RAPIDComm server is located on a different 
PC, specify the RAPIDComm server name or IP address when prompted.

10. Click Install to install the RAPIDComm Web Application software.
11. Click Finish to complete the installation, and then restart Windows. 

Upgrading the RAPIDComm Web App Software
When you upgrade the RAPIDComm Web Server to Version 7.0, the 
upgrade process will use the installation destination folder, web site name, 
and web server name previously defined for the RAPIDComm 6.0 or 6.2 
Web Server. 
To upgrade the RAPIDComm 7.0 Web Application software:
1. On the computer that you have chosen to be the IIS Web Server for the 

RAPIDComm Web App, log on as an administrator. 
2. Open the folder that contains the installation files and double-click 

setup.exe.
3. The installation checks for the installation of Microsoft .NET Framework 

4.5.2. If it is not installed, it will prompt you to install it before installing 
the RAPIDComm Web App software. Click Install.
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4. The Welcome window appears. Click Next to continue.
5. The License Agreement window appears. Click I accept the terms in 

the license agreement.
6. Click Next to continue.
7. Click Install to install the RAPIDComm Web Application software.
8. Click Finish to complete the installation, and then restart Windows. 

Accessing the RAPIDComm Web Application
To use the Web App, you will need the appropriate role assigned to your 
RAPIDComm user group. 

If your facility has the intranet blocked, contact your IT Department to 
enable it so that you are able to access the RAPIDComm server using a 
browser.
You can access the RAPIDComm Web App using any HTML5-compliant 
browser, for example, Internet Explorer 10, Firefox, or Chrome. 
To access the Web App:
1. Open the web browser on your computer or iPad and, in the address 

bar, type: http://<IIS Web Server name or IP Address>/rapidcomm 
Note  To access the secure connection feature, use HTTPS.

2. Press Enter. The Sign In page displays.
3. Optionally, you can add the Sign In page to the iPad home screen, 

which will then appear as a clickable icon (Figure 3-1 and Figure 3-2).

RAPIDComm Role Functionality
Web User Access the Web App
Operator Manager Use operator management features
Device Operator Use device status features
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4. Sign into the Web App with your existing RAPIDComm user ID and 
password. 
The username must be in Domain\username format.

Figure 3-1: Adding an icon to the iPad home screen 

Figure 3-2: RAPIDComm icon on the iPad home screen
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Additional Considerations
• To use Device Link functionality on the browser, port 5443 must be 

open on the IIS Web server to enable communication in case your 
facility has a firewall between clients and instruments.

• When using a web browser on a PC to access the Web App, you have to 
use the mouse to scroll.
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4  Upgrading RAPIDComm Software
This chapter describes how to upgrade to RAPIDComm Data Management 
System Software version 7.0. 

Upgrade Considerations
Prior to initiating the upgrade process, note the following upgrade 
considerations:
• Siemens recommends that your IT department perform this upgrade.
• Systems currently running RAPIDComm software version 6.0, 6.1 or 6.2 

can be upgraded to software version 7.0 directly. 
• If you are running RAPIDComm software version 4.0 or 5.0, you must 

upgrade to version 6.1 before upgrading to software version 7.0. 
• If you are running RAPIDComm software version 1.0, 1.1, or 2.0, you 

must upgrade to software version 3.0 and then to 5.0 and then to 6.1 
before upgrading to software version 7.0. 

• If you are running RAPIDComm software version 3.0, you must upgrade 
to software version 5.0 and then 6.1 before upgrading to software 
version 7.0. 
To confirm the software version you currently have installed, launch 
the RAPIDComm application and click Help > About. The software 
version will be the first 2 numbers following the Version. For example, 
4.0.3118 is version 4.0.

• IT support is required:
○ For access to any RAPIDComm clients or workstations and access to 

all analyzers in case communications need to be reset. Be sure that 
you have an admin account (or an IT contact) to upgrade any 
workstations and/or clients to RAPIDComm 7.0.

○ For server access and HIS/LIS support, if interfaces need to be 
restarted or hospital connection rules need minor changes.

○ For e-mail system, if you will use PEP Admin or automatic email 
alert notifications.

○ For Internet Information Server (IIS) configuration if you will use 
the RAPIDComm Web App.

○ For SQL Server administration, if you are using a remote SQL Server 
database.
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○ For any LIS interface changes that may be required. Review the 
New Considerations for Hospital Connection Interfaces on page 45 
for more information.

• To upgrade to software version 7.0, you must log into Windows with 
administrative privileges. Complete the section Performing Pre-
Upgrade Backup Tasks on page 41, before you begin the upgrade 
process. This section helps you identify information to enter during the 
upgrade process, and describes the initial RAPIDComm application 
status required at workstations and client computers prior to 
performing an upgrade.

• The installation program automatically uninstalls the RAPIDComm/
POCcelerator Operator Integration tool. This functionality has been 
added to the version 7.0 application.

• The RAPIDComm Data Management System supports Blood Gas, 
Cardiac, Diabetes, Urinalysis, or a combination of these components. 
You will need to choose only the applicable device component(s) that 
you are adding during the upgrade process. Any existing components 
will be chosen by default.

• If you are adding new components, you must register on the product 
website after the upgrade. You will use the new product key emailed to 
you for this registration. If you are upgrading directly and are not 
adding additional device components, registration is not required.

• Be aware that there is a period of downtime while the RAPIDComm 
server is being upgraded: 
○ RAPIDComm server downtime should only be about 30 minutes but 

you should prepare for a minimum of 2 hours.
○ Ensure the RAPIDComm full backup operation is currently 

successful and estimate how long the full backup takes to 
complete, and factor that into potential downtime.
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Pre-Upgrade Checklist
Use the following checklist to ensure all required pre-upgrade procedures 
are completed before performing the upgrade. You must resolve any issues 
before proceeding with the upgrade.

□ Verify System Software Configuration

1. Identify your Windows Server OS and SQL Server Software Versions. 
See Identify Windows Server OS and SQL Server Software Version 
Information on page 38.
For instructions on how to identify Windows Server OS and SQL 
Server software version information, refer to Appendix A, 
Identifying Software Versions.

2. Verify system requirements by comparing your system software 
configuration to ensure it meets the criteria in Table 4-2, Supported 
System Software Configurations.

3. If necessary, install the required Windows Server or SQL Server 
service packs and restart your system. See Install Required Service 
Packs on page 39.

□ Ensure that there is sufficient hard disk space on the drive where 
RAPIDComm is installed. Refer to Table 2-1, Minimum Hardware 
Requirements for disk space requirements.

□ Identify Installation Account and Service Account. See Identifying 
Installation and Service Account Information on page 39.

□ Ensure the RAPIDComm Service Account on the server meets the 
following criteria:
□ Is designated as the log on account for the three RAPIDComm 

services.
□ Is the database owner for the three RAPIDComm databases in SQL 

Server. You can identify the database owner by viewing the 
database properties in SQL Management Studio.

□ Matches the DBA account field in the Rapidcomm database 
dbo.Misc table. 
To view the table contents, open SQL Management Studio, select 
the rapidcomm database and then run the query select * from 
dbo.misc.
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Verifying Your System Software Configuration
To verify your software configuration, identify the Windows Server OS and 
SQL Server Software version on your system and compare it to the system 
software configurations supported by RAPIDComm 7.0. 

Identify Windows Server OS and SQL Server Software 
Version Information
Identify the software versions of the Windows Server operating system and 
the SQL Server software on your system and record the information in 
Table 4-1. 
Refer to Appendix A, Identifying Software Versions for information on how 
to identify software version information on Window Server and SQL Server.
Table 4-1:     Windows Server OS and SQL Server Software Version Information

Verify System Requirements
Table 4-2 lists the system configurations supported by RAPIDComm 7.0 
and the required minimum service packs. 
Note  If you currently have a system configuration not listed below, do not 
proceed with the upgrade. Contact your local Siemens support provider for 
assistance.

□ Perform Pre-Upgrade Backup Tasks. See Performing Pre-Upgrade 
Backup Tasks on page 41. 
Note  Ensure that there are no samples in the Patient and QC validation 
queues or duplicates lists. If so, these should be processed/removed 
prior to running a backup or performing an upgrading.

□ Verify Database Compatibility. See Verifying Database Compatibility on 
page 42.

Software Version Service Pack
Windows Server 
Operating System
SQL Server
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Table 4-2:     Supported System Software Configurations

Install Required Service Packs 
To install required service packs for Windows Server and SQL Server:
1. Download and install the software from the Microsoft website. 
2. After you have finished installing any necessary service packs, restart 

your system.

Identifying Installation and Service Account Information 
You need to identify account information for both the Installation Account 
and the Service Account. The Installation Account is a domain account that 
has the privileges needed to install and upgrade software on the server, 
workstations and clients. The Service Account is the account that owns the 
RAPIDComm software and its services on the RAPIDComm Server. 

Component
Windows 
Operating System

Service 
Pack

Microsoft SQL 
Server

Service 
Pack

Server Windows Server 
2008 Standard 
Edition (32-bit)

SP2 SQL Server 
2008 
Workgroup 
Edition  
(32-bit)

SP4

Windows Server 
2008 Standard 
Edition (64-bit)

SP2 SQL Server 
2008 
Workgroup 
Edition 
(64-bit)

SP4

Windows Server 
2008 R2 (64-bit)

SP1 SQL Server 
2008 R2 

SP3

Windows Server 
2012 R2 (64-bit)

N/A SQL Server 
2012 (64-bit)

SP2

Workstation/
Client

Windows 8.1 
Standard Edition 
(64-bit)

N/A N/A N/A

Windows 7 
Professional  
(32-bit)

SP1 N/A N/A

Window 7 
Professional 
(64-bit)

SP1 N/A N/A
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The Service Account domain and username must be in the format of 
<domain>\<username>. RAPIDComm is not compatible with User Principal 
Name (UPN) formatting (for example, user@domain). 

Note  The service account name or the domain name cannot be 
changed during upgrade. Contact your local Siemens support provider 
for instructions to change either name.

To identify account information:
1. If you do not know the account names, domains, and passwords for 

either the Installation Account and the Service Account, contact your 
IT administrator to get this information.

2. Record this information in Table 4-3, Install and Service Account 
Information.

Table 4-3:     Install and Service Account Information

Note  Siemens strongly recommends that you change your Service 
Account password frequently for security purposes. After you change your 
password, be sure you update the password in Windows Services for each 
of the RAPIDComm services:
• Rapidcomm Backup Services Server
• Rapidcomm Business Services Server
• Rapidcomm Communication Services Server
• Rapidcomm Hospital Connection Services Server

Installation Account Service Account
Name
Domain
Password
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Performing Pre-Upgrade Backup Tasks
Before beginning the upgrade, ensure the following backup activities are 
performed:
• If you are using a virtual server, request that IT create a snapshot of the 

virtual machine before performing the upgrade.
• Create a new backup folder, preferably on a separate physical drive 

from the RAPIDComm installation.
• Ensure that there are no samples in the Patient and QC validation 

queues or duplicates lists. If so, these should be processed/removed 
prior to running a backup or performing an upgrading.

1. Perform a RAPIDComm database backup:
If you are using RAPIDComm to perform a database backup, do the 
following:
a. Log in to RAPIDComm and click Utilities > Manage Database > 

Back Up Data.
b. Click Run Full Backup and then click OK.
c. Periodically click the Refresh button until you can confirm that the 

Status column shows that the full backup was successful and that 
the Last Run Time value is that of the current backup.

Note  If the backup was not successful, do not proceed with the 
upgrade and contact your local Siemens support for assistance. 
If the default RAPIDComm backup plans have been altered, the IT 
department should perform a full backup of the RAPIDComm database 
using their maintenance plans.

2. Copy the RAPIDComm backups to the newly created backup folder.
3. Copy the Siemens.Rapidcomm.Gateway.Server.exe.config file to the 

new backup folder. By default, this file is located in the RAPIDComm 
installation directory, C:\Program Files\Siemens\Rapidcomm.

4. Copy the Siemens.Rapidcomm.Security.SecurityManager.dll. 
RoleMapByGroup.xml file to the new backup folder. By default, this file 
is located in the RAPIDComm installation directory, C:\Program 
Files\Siemens\Rapidcomm.
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Verifying Database Compatibility
Before you attempt to upgrade to RAPIDComm 7.0, check the current 
database compatibility level in SQL Management Studio.
To do this in SQL Server 2008:
1. Open Microsoft SQL Server Management Studio.
2. On the tree, expand Databases.
3. Right-click the Rapidcomm database and select Properties.
4. Click Options and make sure the Compatibility level is set to SQL 

Server 2008. 
5. Repeat steps 1–4 for the RapidcommAudit and RapidcommGateway 

databases and then exit management studio.
To do this in SQL Server 2012:
1. Open Microsoft SQL Server Management Studio.
2. On the tree, expand Databases.
3. Right-click the Rapidcomm database and select Properties.
4. Click Options and make sure the Compatibility level is set to SQL 

Server 2012. 
5. Repeat steps 1–4 for the RapidcommAudit and RapidcommGateway 

databases and then exit management studio.
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Upgrading RAPIDComm Software on the Server
To upgrade RAPIDComm software on the server:
1. Confirm that the RAPIDComm application services and user interface 

are closed on all workstation and client systems.
a. In the RAPIDComm application for each workstation and client, click 

System > Exit or Sign Out.
b. Exit all open Windows applications on the server.
c. Leave the computer logged in and at the Desktop screen.

2. Confirm that the RAPIDComm application services are running on the 
server. 
On Windows 2012:
a. Click Start > Administrative Tools. 
b. Click Services. The status for the three RAPIDComm services should 

be Running.
On Windows 2008:
a. Click Start > Administrative Tools > Server Manager.
b. Expand Configuration, click Services and then click the Standards 

tab. The status for the three RAPIDComm services should be 
Started.

3. Click System > Exit to close the RAPIDComm user interface on the 
server if it is running. 

4. Open the folder that contains the installation files and double-click 
setup.exe.

5. The RAPIDComm InstallShield Wizard starts and checks to ensure that 
the Microsoft .NET Framework 4.5.2 Full and SAP Crystal Reports 
runtime engine for .NET Framework 4.5.2 (x86 or x64) needed for 
RAPIDComm 7.0 are installed. If either is not installed, it will open a 
window showing which is needed and request approval to install 
missing components. To approve, click Install. During this time, do not 
interrupt or cancel the process. 
Note  These components should not be removed once installed.
It will take several minutes for each to install. If prompted, reboot your 
system. 

6. A reminder screen appears indicating that a manual, full backup is 
recommended before upgrading. Do one of the following:
a. If you have performed a backup, click OK to continue. 
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b. If you have not performed a backup, click Cancel to stop the 
installation and perform the backup. The installation will exit but 
the required components installed in step 5 will not be removed. 
You will enter at this point when you restart the installation by 
double-clicking Setup.exe in the installation directory.

7. The InstallShield Wizard window appears and the space available is 
computed to ensure that there is enough space for a successful 
upgrade. Click Next to continue with the installation.

8. The License Agreement window appears. Select the I accept the 
terms in the license agreement checkbox.
Note  If you need a copy of the license agreement, you can print it 
before leaving this screen.

9. Click Next. 
10. The Device Component Selection dialog window appears. Choose any 

additional components to be installed based on any changes to the list 
of products you have licensed. All existing components will be checked 
and grayed out.

11. Click Next. 
12. The RAPIDComm Service Account window appears. Type the Service 

Account password you recorded in Table 4-3. The Account and 
Domain fields are disabled to indicate that these fields cannot be 
changed during an upgrade.

13. Enter the Password of the listed account. Click Next.
14. The Ready to Install the Program window appears. Click Back if you 

need to revise any previous entries.
15. Click Install.

The Installing RAPIDComm window appears. The installation will take 
several minutes to complete.
Note  Do not click Cancel to stop this installation.
The InstallShield Wizard Completed window appears when all 
components have been successfully installed.

16. Click Finish to complete the installation.
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Registering RAPIDComm
If you are not adding new components with the version 7.0 upgrade, you 
do not need to re-register RAPIDComm. 
If you have added new components to your license, you must re-register 
RAPIDComm as described below.
To re-register RAPIDComm:
1. Sign-in to the RAPIDComm software as an application administrator.
2. Click Utilities > Product Registration.
3. Click Update.
4. Follow the on-screen instructions to enter the new Product Key from 

your new software certificate and complete the product registration 
process.

Verifying Server Operations Post Upgrade
After the upgrade is complete, perform the following steps:
1. Using RAPIDComm, perform a full backup of the database and ensure 

that it completes successfully.
2. Check the status of the devices in RAPIDComm and ensure that they are 

communicating.
3. Run test samples on one or more analyzers. Ensure that the samples:

• Appear in RAPIDComm
• Are received by the LIS system, if applicable

4. Copy the backup folder created previously to the RAPIDComm 
installation directory. Name the folder RAPIDComm 7.0 Backup Files.

New Considerations for Hospital Connection Interfaces
If you have configured any ADT, Orders, Patient Query, or Results hospital 
connections, when you upgrade to RAPIDComm 7.0, the hospital 
connection settings are retained and migrated:
• ADT, Orders or Patient Query connections are migrated directly to new 

ADT, Orders, or Patient Query connections using their current 
connection names.

• Device type based Results connections are migrated to new individual 
Results connections, such as R1, R2, R3, using their current connection 
names. 
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• Conflicting or unsupported characters used in any hospital connection 
name are replaced with a tilde (~).

• Any preexisting IP address and port configurations (that would be 
considered a conflict in version 6.1) will retain their current 
configuration without alteration. However, if you subsequently edit 
one of these fields it will require you to enter new, unique IP addresses 
and port settings.
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Upgrading the RAPIDComm Software on Workstations and 
Clients

To upgrade RAPIDComm software on a workstation or client:
1. Log in to the workstation or client with required privileges.
2. Consult Table 4-2, Supported System Software Configurations and 

upgrade your system to the service pack listed or higher.
3. Open the folder that contains the upgrade files and double-click 

setup.exe.
Note  It may take several minutes before the InstallShield Wizard 
appears to check for and install required .NET software. During this 
time, do not interrupted or cancel the upgrade process.
The system performs the following actions:
• The InstallShield Wizard window appears.
• The Preparing to Install window appears, followed by the 

Welcome to the InstallShield Wizard for RAPIDComm 7.0 
window.

4. Click Next.
5. If you are installing the RAPIDComm software on a client, go to step 7.

If you are installing the software on a workstation, the RAPIDComm 
Service Account window appears.

6. Enter the Service Account password you recorded in Table 4-3, Install 
and Service Account Information.
The Account and Domain fields are disabled to indicate that these 
fields cannot be changed during an upgrade.

7. Click Next.
The Ready to Install the Program window appears.

8. Click Back if you need to revise a previous entry.
9. Click Install.

The Installing RAPIDComm screen appears.
Note  Do not click Cancel to stop this installation.
The InstallShield Wizard Completed window appears.

10. Click Finish.
11. If requested, reboot the computer. Otherwise, restart the RAPIDComm 

application.
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5  Adding and Registering Device 
Components

This chapter describes how to add and remove components from 
RAPIDComm.

Adding and Removing Device Components
To add or remove a device component:
1. On the Windows task bar, click Start > Control Panel > Programs > 

Programs and Features. 
2. Click RAPIDComm 7.0 Server, right click and select the Change 

option.
The Welcome to InstallShield Wizard for RAPIDComm window 
appears.

3. Click Next.
The Device Component Selection window appears. 

Note  To interrupt and back up the install process, click Cancel.
4. To add a component:

a. Select the checkbox next to the component to add.
b. Click Next.

The Ready to Install the Program window appears.
c. To continue, click Install.

The Installing RAPIDComm window with progress bar appears.
When the install process completes, the InstallShield Wizard 
window appears.

d. Click Finish.
5. To remove a component:

a. Clear the checkbox to the left of the component to remove.
A window appears warning you that removing a component will 
result in the loss of any associated data.

b. Click OK.
c. Click Next.

The Ready to Install the Program window appears.
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d. To continue, click Install.
The Installing RAPIDComm window with progress bar appears.
When the install process completes the InstallShield Wizard 
Completed window appears.

e. Click Finish.
If you do not change any of the selections, a window appears 
indicating that no maintenance actions will take place. Click OK.

6. To exit the Add/Remove process when you did not add or remove 
components:
a. Click Cancel.
b. On the Confirmation window, click Yes.
c. Click Exit.

Registering Device Components
The RAPIDComm Data Management software can include Blood Gas, 
Cardiac, Diabetes, Urinalysis, or any combination of these components. 

After Installation
You register components after you have finished installing the 
RAPIDComm software on the server.
To register component(s):
1. Obtain the product key included in your RAPIDComm software 

certificate that was emailed to you.
2. Log on to the RAPIDComm Data Management System software as an 

Application Administrator.
3. Click Utilities > Product Registration.
Follow instructions on the window to complete the product registration.
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After Upgrade
When you add new components to your license, you must re-register 
RAPIDComm as described below.
To re-register RAPIDComm:
1. Sign-in to the RAPIDComm software as an application administrator.
2. Click Utilities > Product Registration.
3. Click Update.
Follow the on-screen instructions to enter the new Product Key that was 
emailed to you and complete the product registration process.
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Appendix A:     Identifying Software Versions
This Appendix describes how to identify the software versions of the 
Windows Server operating system and the SQL Server software on your 
system. 

Identifying Windows Server OS Software Versions
After you have identified the operating system and service pack 
information, record the information in Table 4-1, Windows Server OS and 
SQL Server Software Version Information.

Windows Server 2012 R2 or 2016
To identify the software version information on a Windows 2012 R2 or 
Windows Server 2016 system, click Start > Control Panel > System and 
Security > System.
The operating system and service pack appear in the Windows Edition 
section.

Windows Server 2008 R2
To identify and record the software version information on a Windows 
2008 R2 system:
1. Click Start, and right-click Computer.
2. Click Properties.

The operating system and service pack appear in the Windows Edition 
section.

Identifying SQL Server Software Versions
SQL Server 2012 or 2016
To identify the installed SQL Server software version and service pack on a 
system running SQL Server 2012 or SQL Server 2016:
1. Open the SQL Server Management Studio.
2. On the Connect to Server window, in the Authentication field 

confirm that Windows Authentication appears. Click Connect to 
connect to the database.
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3. The Object Explorer Details pane appears. If the pane does not open 
by default, from the View menu, click Object Explorer Details or click 
F8. 

4. You can determine the software version from the header of the Object 
Explorer Details window, which reads from left to right: 
<node name> (SQL server M.m.Fn - <login account)>, 
where,
• M.m indicates the software version 
• Fn indicates the service pack (see Table A-1 or Table A-2)
If the Fn is greater than one of the values in Table A-1 or Table A-2, 
choose the service pack with the lower value. For example in Table A-1, 
11.00.5343 is a cumulative update for SQL Server 2012 Service Pack 2, 
so you would record Service Pack 2 (5343 is lower than 5058).

Table A-1:     SQL Server 2012 Service Packs

Table A-2:     SQL Server 2016 Service Packs

SQL Server 2008 or 2008 R2
To identify the installed SQL Server software version and service pack on a 
system running SQL Server 2008 or 2008 R2:
1. Open the SQL Server Management Studio by clicking Start > All 

Programs > Microsoft SQL Server 2008 > SQL Server Management 
Studio.

2. On the Connect to Server window, confirm that Windows 
Authentication appears on the Authentication line. Click Connect to 
connect to the database.

3. The Object Explorer Details window appears. If the window does not 
open by default, from the View menu, click Object Explorer Details. 

Fn Field Service Pack
11.0.2100.60 No Service Pack (RTM)
11.0.3000.0 Service Pack 1 (SP1)
11.0.5058.0 Service Pack 2 (SP2)

Fn Field Service Pack
13.00.1601.5 No Service Pack (RTM)
13.0.4001.0 Service Pack 1 (SP1)
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4. You can determine the software version from the header of the Object 
Explorer Details window, which reads from left to right: 
<node name> (SQL server M.m.Fn - <login account)>
where,
• M.m indicates the software version (10.0 for SQL Server 2008 or 

10.5 for SQL Server 2008 R2) 
•  Fn indicates the service pack(see Table A-3 or Table A-4)
If the Fn is greater than one of the values in Table A-3 or Table A-4, 
choose the service pack with the lower value. For example, 10.00.4266 
is a cumulative update for SQL Server 2008 Service Pack 2, so you 
would record Service Pack 2 (4000 is lower than 4266).

5. Record software version and service pack numbers in Table 4-1, 
Windows Server OS and SQL Server Software Version Information. 

Table A-3:     SQL Server 2008 Service Packs

Table A-4:     SQL Server 2008 R2 Service Packs

Fn Field Service Pack
1600.22 No Service Pack (RTM)
2531.00 Service Pack 1 (SP1)
4000.00 Service Pack 2 (SP2)
5500.00 Service Pack 3 (SP3)
6000.29 Service Pack 4 (SP4)

Fn Field Service Pack
1600.1 No Service Pack (RTM)
2500.0 Service Pack 1 (SP1)
4000.0 Service Pack 2 (SP2)
6000.34 Service Pack 3 (SP3)
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